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I 'm pleased to be given the opportunity to 
introduce myself to the Melbourne 

Camera Club (MCC) and to describe some 
of my photographic interests (a favourite 
pastime).  
 Many of us can identify a person who 
provided us with encouragement to take up 
the rewarding hobby of photography. For 
me it was my grandfather Harold Ewen, a 
keen photographer for most of his 90+ 
years. In my early teens (the 1960s), our 
first task was to build printing equipment 
to a strict budget. I recall a favourite 
negative of my grandfathers providing a 
valuable resource for printing and toning. 
This image of the Melbourne tugboat 
James Patterson was taken in the late 
1940s using a German roll film camera 
(Super Iconta) and represented my 
grandfathers interest in everything 
Melbourne, something I share to this day. 
 I was fortunate to have been given a 

technical education finishing with a 
Diploma in Applied Chemistry from 
Swinburne. This lead to a career in 
materials research (road construction) with 
the Australian Road Research Board in 
Melbourne holding various positions from 
1973 to 2011 when I retired as Principal 
Research Scientist. 
 Like many in the MCC, I found 

several opportunities to use my interest 
in photography to help solve work 
problems. A challenge we were facing 
related to the need to record and measure 
the diurnal movements (caused by 
changes in temperature) and seasonal 
movements (caused by changes in 
moisture) in pavement cracks. This work 
was undertaken to help identify the 
necessary properties required by road 
surfacing materials. It began in the film 
era and resulted in the development of a 
precision camera for recording images of 
pavement surface cracks as a time series. 
A subsequent darkroom manipulation 

allowed changes in crack dimension to be 
determined. The digital era subsequently 
allowed a simpler system to be developed 
and using the same time series of images 
resulted in a further improvement in 
convenience and measurement precision. 
This later digital data was analyzed in the 
computer. 
 While pursuing these research 
interests I was fortunate to travel through 
much of Australia and in particular the 
arid areas of Central and Northern 
Australia. While driving to the many and 
varied locations, often on my own, I 
found many opportunities to record the 
outback in its many liveries. This taught 
me to carry a camera as often as the 
situation allowed.  
 With retirement a few years ago I'm 
now able to dedicate more time to my 
photography and with the encouragement 
of my family will be seeking new 
challenges through the MCC. My "to-do" 
list includes: 

 Developing workshop skills to enable 
the manufacture of various cameras for 
improved close-up and high depth of field 
still life photography. I joined the 
Melbourne-based Australian Antiquarian 
Horological Society (AAHS) two years 
ago to train with some of Australia's most 
talented machinists and engineers. This 
has been a rewarding experience and has 
provided several photo opportunities 
unique to this group. The newly acquired 
engineering skills should contribute to the 
building of a digital rotating panorama 
camera (and other challenges). 

 Improving my portraiture results 
through participation in the MCC 

My World 
Peter Tredrea 

Self-portrait 

James Patterson - photo by Harold Ewen 

Harold Ewen 

Film-based camera system to monitor road 
cracks - The box contains two low power 
flash units and an 80 mm Rodagon 
enlarging lens. These optics can be very 
useful in many areas of close-up 
photography producing a high resolution 
flat image. 

Digital camera system for monitoring road 
cracks - This made use of the camera's inbuilt 
flash to channel the light by reflectors onto 
the pavement surface. Various lenses were 
used including an AF 100 mm micro-Nikkor. 
The automation of the modern camera was 
put to good use. 
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After Karsh - Responding to the challenge 
set for the 2013 end-of-year competition, I 
borrowed my wife's dressmaking mannequin 
and followed the guidance provided by the 
Lighting Group to reproduce a Yousuf 
Karsh-like setup. 

Portrait - After several hours of static 
practice, my very patient subject assisted with 
the creation of several images - to date my 
most structured sequence of photographs. 

Built Melbourne - Following my Grandfather's interest in a "built Melbourne", I have 
been following recent major projects including the new County Court, Queen 
Victoria site and this, the Myer Lonsdale street store redevelopment. To reach these 
images, a three meter monopod was constructed. After several heated discussions 
with New Zealand-sourced property guards, the images have been rewarding, though 
sometimes difficult to obtain.  

Calisthenics - My wife Janet and our two daughters have an interest in 
calisthenics, a stage-based song, dance and exercise sport for girls. My 
role is to provide a range of photography covering each year's work. To 
cover some of the stage presentations my girls encouraged me to purchase 
a 70-200 mm Nikkor. After much arm twisting I succumbed to their 
pressure and made the purchase. Life is tough sometimes. 

Clock Club - Providing photographic support to the AAHS (Clock 
Club) gave me an opportunity to visit a master clock-maker in 
New South Wales. This image is of his latest work and I hope to 
make a return visit when the timepiece is completed in about two 
years time. 

Mount Burnett Observatory - Celebrating two years as a community-based 
facility, the Mount Burnett Observatory (formerly Monash University's research 
telescope) provided an opportunity to experience and learn more about a large 
astronomical telescope. I plan to use a smaller telescope to generate some 
Melbourne skyline images with a twist. 

Lighting Group and Print Review 
Group. The print competition and EDI 
competition frequency and structure at 
the MCC has encouraged critical 
review of my approach to many topics 
and I hope a steady improvement in 
subject interpretation and image and 
print quality. 
 Another area of interest is 
traditional film based imaging. While 
dormant for several years, it is now 
back in full swing through the 
encouragement of the Traditional 
Darkroom Printmakers Group. As a 
collector and hoarder of anything 
photographic I hope to use my 
resources and produce a large format 
(A3 or larger) camera for direct image 
capture on reversal paper. 
 The images here, and commentary 
illustrate some of my interests and new 
directions. 

Cover Image 
Peter Tredrea  

 Rock and a Hard Place 
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Removing Unwanted People 
Charles Kosina 

H ow often do you come to a place with 
marvellous scenery and it is crawling 

with people? Sometimes having one or two 
persons in the image gives it a sense of 
scale, but often they are just a nuisance. 
 This was very much the case in our 
visit to the Buchart Gardens on Vancouver 
Island in August last year. The gardens 
were magnificent, the weather perfect, but 
it seemed that half the island were there 
also. A highlight is looking down onto the 
sunken garden. After spending a frustrating 
time trying to take a photo with a minimum 
number of people in the frame, we went off 
for an afternoon coffee and there I devised 
a way to get rid of all the people! I am sure 
that I am not the first one to have worked 
out how to do this as it is really quite 
straightforward. 
 First, I set up the camera on a tripod 
and was careful that no-one bumped it. 
Then I took a series of photos at intervals 
of a few seconds whilst watching the 
people moving around below. The idea was 
to make sure that I had sufficient 
background information to then layer the 
images and erase the offending people. 
 In this example I will just use the four 
images 1-4 shown (slightly cropped). 
Select two images in separate layers and on 
the top layer use the erase tool to remove a 
person and leave the background. Then 
flatten image and select another layer and 
repeat process until no people are left. 
 Of course this will only work when 
there are not too many people. And there 
should be constant light during all the 
images. And as you can see, there is no-
one in the final image! 

1 2 

3 4 

June Mono EDI of Month 
 George Chan  Golden Fish 

 AGM Notice 
 

 The next Annual General Meeting of the Melbourne Camera 
Club will be held on Thursday 2nd October 2014 at 8pm at the club-
rooms, corner of Dorcas and Ferrars Street, South Melbourne. 

“Selfie” by Ian Bock  HC in July EDI Competition 



O ur Thursday night Competitions 
are alive and well at the MCC. 

Over the past three months we have 
averaged 111 print entries each month 
and 121 entries for our projected 
digital images ( EDI ) each month. Set 
subject entries are popular although 
more members are involved in the EDI  
competition than printmakers. 
 The Competition Committee are 
now selecting the ‘Set Subjects’ for the 
whole 2015 competition year and this 
list will soon be made available. 
 Have you looked at our Club`s 
web-site recently ?  
www.melbournephoto.org.au 
 Those images that scroll across 
our site are awarded images from the 
2014 EDI competitions to date. A 
simple click on one of those moving 
images will bring that image to almost 
full screen, give details, member’s 
name etc. A further click on the name 
will then bring up other awarded 
images by that member. 
 Earlier this year the Australian 
Photographic Society ( APS ) made a 
decision to dispose of its large historic 
collection of prints, some dating back 
over forty-five years, as well as some 
old film cameras and equipment. 

 When members of our Club heard 
of this our Board was advised and we 
formally asked that these prints and 
archive records be gifted over to the 
MCC. Our offer was accepted and in 
time most of these prints will be 
merged into our existing historic 
archive collection. In time our club 
Archivist, Alan Elliott will be calling 
for volunteers to help in this process. 
Fortunately these newly acquired 
prints were digitized and we will 
receive a copy of those digital records 
as well. 
 Elsewhere in this issue is a formal 
notice advising members that the 2014 
Annual General Meeting of the MCC 
is to be held on Thursday 2nd October. 
Towards the end of August the Hon. 
Secretary of MCC will be posting on 
t h e  C l u b ` s  n o t i c e  b o a r d  a 
“Nominations notice” calling for 
nominations for the various vacant 
positions on the MCC Board.  
 All members are asked to consider 
in what way they may be able to 
contribute to the running of their 
camera club. I would like to see some 
of our newer and/or younger members 
step up and be more involved.   
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The Melbourne  
Camera Club 

ACN 004 344 549 ABN 79 004 344 549 
 

CLUB CONTACTS 
Clubrooms 

Corner of Ferrars and Dorcas Streets, 
South Melbourne 
Phone 9696 5445 

PO Box 1180, Sth Melbourne 3205 
www.melbournephoto.org.au 

 

 President 
Barrie Bunning 

mcc-president@melbournephoto.org.au 
 

Secretary 
Greg Hotson 

mcc-secretary@melbournephoto.org.au 
 

Treasurer 
Gary Richardson 

mcc-treasurer@melbournephoto.org.au 
  

General Questions 
mcc-info@melbournephoto.org.au  

 

Portrait Group  
Dion Chapman and John van Hirsel 

mcc-portrait@melbournephoto.org.au 
 
 

Club Facilities Booking Coordinator 
Selby Markham 

mcc-bookings@melbournephoto.org.au 
 

Introduction Photography Course  
Contact Secretary 

mcc-courses@melbournephoto.org.au  
New Member Orientation Coordination 

Frances Egan and Greg Hotson 
mcc-newmember@melbournephoto.org.au  

 

Traditional Darkroom 
 Printmakers Group  

Selby Markham  
 mcc-blackandwhite@melbournephoto.org.au 
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Digital Group 
Kelvin Rowley 

mcc-digital@melbournephoto.org.au 
 

Print Competition Steward 
 Shelly Black and Frances Egan 

mcc-print-comp@melbournephoto.org.au  
 

EDI Competition Stewards 
 Alan Harper, Gary Richards, Robert Fairweather 

mcc-edi-comp@melbournephoto.org.au 
 

Audio Visual Group 
 John Spring 

mcc-audiovisual@melbournephoto.org.au  
 

 International Competitions 
 Vacant  

 

Photo Discussion Group  
Simon Galbally  

mcc-photodiscuss@melbournephoto.org.au  
 

Librarian  
John Jovic 

mcc-library@melbournephoto.org.au  
 

Photographic Lighting Group 
David Gilliver 

mcc-lighting@melbournephoto.org.au 
 
 

MCC Website 
Manager - Alan Harper 

mcc-webmaster@melbournephoto.org.au 
Website Content - Gary Richardson 

mcc-webcontent@melbournephoto.org.au 
mcc-photos@melbournephoto.org.au 

 

Program Coordinator 
John Spring 

mcc-program@melbournephoto.org.au  
 

Exposure Editors 
Phil Marley and Charles Kosina 

mcc-exposure@melbournephoto.org.au 

President’s Report 
Barrie Bunning 

1. Copy the background to a new layer. Layer>New>Layer via copy (or Ctrl + J). 
 

2. Invert the new layer. Image>Adjustments>Invert (or Ctrl + I). 
 

3. Convert the new layer to black and white. Image>Adjustments>Desaturate 
 (or Shift + Ctrl + U). 
 

4. Blur the new layer.  Filter>Blur>Gaussian Blur radius 250 pixels. 
 

5. Change the blending mode of the new layer from Normal to Overlay and adjust 
the Opacity to taste. Before and After are shown below. 

How to add life to your image in 5 easy Photoshop steps 
Gary Richardson 
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B ack in the dim distant past, most cameras lacked any 
form of rangefinder, let alone autofocus. If you 

wanted a picture that was in focus you had to estimate the 
distance an object was from the camera and set the lens to 
that distance. Working at infinity was, obviously, OK but 
not when you were composing that shot of family or 
friends about 5 to 10 metres away. You had to estimate the 
distance and set your focus ring to that distance. 
 The aid to doing all this was a rangefinder that you 
either fitted into the flash shoe or held in your hand. At the 
core of a rangefinder is an interacting pair of images. 
Correct focus is achieved when both of the images become 
a single image. There is an excellent description of the 
mechanism at: http://www.photozone.de/slr-vs-
rangefinder. A diagram from that site shows the generic 
structure of the rangefinder as implemented within a 
camera. You see the actual image through F while the 
overlapping image comes in via the prism at E. You can 
see both images because A is a half silvered mirror that is 
similar to a one-way mirror. As the prism is shifted on its 
axis, the two images either come together or move apart 
and it is of the form shown in G. The image is in focus 
when the two images come together. The tool for shifting 
them on its axis has, on a stand-alone rangefinder, a scale 
that you read off. That is the figure transferred to the 
focussing ring of the camera. 
 

 I have a few rangefinders, partly because I have a 
variety of cameras that are manually focussed and some 
are imperial and some are metric. I need rangefinders 
covering both measurement systems. Fig. 2 shows one of 
my Kodak Retinas with the various rangefinders I have. 
The Retinas emphasise the problem with the measurement 
systems for focussing because they were produced for 
both the US and European markets.  
 Kodak is/was very much a USA company. George 
Eastman was the archetypal entrepreneurial capitalist. 
 Even though Germany in the 1930s became a fascist 
state, he took over the production of the Retina range of 

cameras from Nagel Camerawerk in Stuttgart. The Retina 
became the epitome of the high level amateur camera – good 
engineering, reliability and great optics. Eastman, and other 
US business men, traded with Nazi Germany up until (and 
possibly beyond) the US entry into World War II. I have at 
least one Retina that is a product of the Third Reich - a bit 
chilling when I think about the fact it may have been produced 
by slave labour, although Kodak has always denied that this 
could be the case.  

 My favourite rangefinder is the Combi-Meter made by 
Wata. This is the ultimate aid for the photographer using a 
manual camera in the 1950s. Advertisements for the Combi-
Meter in the early 1950s had a UK price of  £4 16s 9p with an 
additional 3s 11p if you wanted the leather carry case. The 
total cost of the Combi-Meter in 2014 terms would probably 
be about £300, about AU$541, if seen in terms of value against 
income - an expensive item for the amateur photographer. 

Getting Things in Focus – Rangefinders 
Selby Markham 

Fig 2. Retina 1b with various rangefinders  

Fig. 3. Combi-Meter combined rangefinder and exposure meter  

Fig. 1. Rangefinder schematic 
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 The rangefinder is used by looking through the smaller of 
the two holes shown in Fig 3. You see two versions of the 
image in which you are interested (Fig.5). You move the 
distance dial until the two images overlaps. The value on the 
dial that is lined up with the reference marker is the value to be 
transferred to the distance scale on the focussing ring of your 
camera. 
 The Combi-Meter, as the name implies, is more than a 
rangefinder: it is also a light meter. The light meter uses one of 
the earliest forms of light level estimation - the extinction 
meter. This is the way Wikipedia describes such a meter: 
 

 “The earliest type of light meters were called 
extinction meters and contained a numbered or lettered 
row of neutral density filters of increasing density. The 
photographer would position the meter in front of his 
subject and note the filter with the greatest density that still 
allowed incident light to pass through. The letter or 
number corresponding to the filter was used as an index 
into a chart of appropriate aperture and shutter speed 
combinations for a given film speed.” 

 
 To use the exposure meter function of the Combi-
Meter you would hold the meter at about arm's length 
pointing at the scene you want to photograph. You would 
look through the larger of the two holes shown in the 
picture and see what the number was that you could just 
make out – the range is 3 to 7. From Fig. 6 you would 
choose 4 as the extinction value for the left hand image 
while you would choose 3 for the right hand image. Then 
you would carry the chosen value across to the top of the 
meter. You can see the extinction values on the left side 
beside the dial in Fig. 3. The dial would be rotated so that 
the DIN value for your film was lined up with the 
extinction value. Next you would go across and choose the 
shutter speed and f stop combination that suites your needs. 
 It is interesting that the Combi-Meter is quite limited 
in its coverage even for the times. There were ISO400 
films in the early 1950s but the Combi-Meter only goes to 
ISO100 – DIN 21. Similarly, many lens had apertures 
smaller than f11, the smallest value shown on the meter. 
 Do I use the extinction meter? No because it is now 
inaccurate, plus the fact that it is difficult to read unless 
your eyesight is good. But I do use the rangefinder on 
imperial marked cameras as it is still accurate enough.  
 Over and above the practicalities, the Combi-Meter is 
a great talking point when people come up and ask about 
the equipment I am using. 

Fig. 6. Extinction display with darker scene values on left 

Fig. 5. Left side - out of focus. Right side - in focus (almost) 

use the pop-up flash to IR control my 
Speedlights, but the light from the 
pop-up doesn't cause the image to be 
badly lit, and the flash firing doesn't 
blind the model constantly! I use the 
Nikon one, which fits standard hot-
shoes and SLR pop-up flashes - about 
$25 at camera shops. I don't know if 
other brands exist. See: 
http://www.nikonusa.com/en/Nikon-
Products/Product/Flash-Couplers/SG-
31R-IR-Panel-for-Built-In-Flash.html 

Gadget Corner 
 

Black Plastic Flash 
Cam Burgess 

 
 One of my favourite gadgets that 
no-one knows about is the Infra Red 
Flash Filter. This clips into a standard 
hotshoe and folds a piece of black-
looking plastic over the pop-up flash, 
blocking the visible flash, but allow-
ing IR signals to pass. This way, I can 
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MCC scores and results in VAPS 2014 Interclub Competitions 

Individual scores 
Open Prints 

Leif Andersen  First Light Wanaka Tree    12 
Jane Barnes  Curvaceous Fields    12 
Ian Bock   New Born      12 
Neil Brink   Mammoth Springs - Yellowstone    9 
George Chan  Through the Window     9 
Jane Clancy  All Alone in the Cold     12 
France Egan   Glacier Bay     12 
David Ellis   Thelma Helen Ellis (Merit)   14  
Kathryn Hocking Webb Bridge      9 
Marg Huxtable  Maternal Instincts    13 
Annette James  Akita Maple     10 
Daryl Lynch  Spectrum       8 
Jim O'Donnell  Mungo Pinnacles     11 
Joanne Rinaldi  Daily Drudge      9 
Peter Walton  First Light      11 
 

Open AVs 
John Spring   Another One (Merit)    44  
Phil Marley   Judgement Day      35 
 

Individual scores 
EDPI 

Jane Barnes     Red Tail Delight       11 
Colin Booth     The Bridge         9 
George Chan     Icy Cube         11 
Jane Clancy     Tasman Glacier Gold      13 
Martin Clancy     Triangles        10 
Frances Egan     Pumping Iron         9 
Robert Fairweather  Shipwreck        10 
Tobi Frost     Mani         10 
John Jovic     Docklands        11 
Charles Kosina    Cathedral Mountain BC      12 
Tuck Leong     Snow Daisies Landscape      11 
Joanne Rinaldi     Smoking Street of Agra      10 
Mark Smith     Lighthouse Spirals 
      at Point Hicks       10 
Peter Tredrea     What time         9 
Jim Weatherill     Bolte Bridge Accident       9 
 

3.21 AVs 
Charles Kosina  Yellowstone Colours     44 
John Spring  In Around Malvern  
    1km From Home     38 

MCC's overall rankings, 4th in Open Prints, 11th in EDPIs 

A lmost all of us know that sinking 
feeling when the full realization 

sinks in that your computer’s hard 
drive has ‘died’ along with your most 
current photo projects and you have 
no current backup! That ‘sinking’ 
feeling to a larger or smaller extent 
can also happen when your USB 
THUMB flash drive corrupts, but the 
worst is a memory card in your digital 
camera suddenly losing images and 
access. 
 Not long ago I received an 
emergency call from a club member 
when the member’s camera SD card 
corrupted with a whole lot of 
important images ‘gone’. What do I 

do?! I cannot see or access any images 
on the card – it says I have to re-
format it to use it! My response was 
first to take the memory card out of the 
camera and store it safely for ‘data 
investigation and retrieval….’ Put 
another card in your camera and keep 
shooting and if possibly reshoot the 
other card’s corrupted images. 
 Now for the good news: the ‘lost’ 
camera card images were all recovered 
using a favorite little program 
RescuePRO recommended  by 
SanDisk. When you purchase your 
next SanDisk memory card look at the 
included long narrow instruction piece 
of paper and check for an offer and 

serial number for a 
t w e l v e  m o n t h 
subscription to the 

DataRecovery software ‘RescuePro’ 
 (http://www.lc-tech.com/rescuepro/). 
 There are a number of great data 
recovery and safeguard programs 
now available for the Photographer 
Photo Editor to be familiar with. 
However there is a level of recovery 
that only a top professional data 
recovery service can provide.  
 I have had to initiate a server 
RAID two HD disk recovery with 
encryption. It was a successful 
recovery but the cost and time out of 
action led to a great deal of anxiety. 
 In November later this year the 
Club will have a presentation night 
finishing with a QA session with one 
of Melbourne’s foremost data 
recovery experts. Don’t miss this 
Preservation & Data Recovery 
presentation Thursday, 27th Nov. 

Data Recovery Issues for the Modern Digital Photographer 
John Spring 

Here are three examples of the type of corruption that 
may occur on a memory card. 
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July Mono EDI of the Month   Martin Clancy  San Remo Bridge 

July Colour EDI of Month  Joanne Rinaldi  Story Telling Moments 
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Monthly Competition Scores to July 

 Name Jun Jul Total 

 George Chan  eec ech 62 

 David Ellis  ecp eec 41 

 Judi Mowlem  eec ecp 40 

 Charles Kosina  eeh ehp 29 

 Peter Tredrea  ecp eee 29 

 Jane Barnes  eee ccc 28 

 Peter Walton    27 

 Joanne Rinaldi  eee eee 26 

 Ian Bock  eec eee 25 

 Annette James   eec 25 

 John Spring  eee eee 24 

 Robert Fairweather  eec eee 23 

 John Parkinson  eee eee 19 

 Marg Huxtable  eee eec 18 

 John Mallett   eee 17 

 Guy Toner   eee 17 

 Leif Andersen  ee eee 9 

 Ken Bretherton  eee  8 
 Jane Clancy    3 

A Grade Open Prints 

 Name Jun Jul Total 

 Sharon King  eec eeh 45 

 Neil Brink  eec eec 42 

 Jim O'donnell  eeh ecc 41 

 Lesley Bretherton  eeh ecc 36 

 Kathryn Hocking  eee eee 27 

 Gail Morgan  eee eee 24 

 Ken Warburton  eec eec 24 

 Robert Norman  eeh ehh 18 

 David Beardsley  eec  17 

 Daryl Lynch    15 

 Rob Gullan  eec  14 

 Colin Booth  eee ee 11 

 Alan Harper    11 

 John Harrison  eee eee 11 

 Brian Seddon   ecc 10 

 Reuben Glass  eee ee 7 

 Martin Clancy    5 

 Shelly Black  eee  3 

B Grade Open Prints 

 Name Jun Jul Total 
 Julie Ughetti  ech eee 56 
 Mark Devaraj  eee eec 27 
 Susan Brunialti  eec ech 26 

 Karin Kowalski    15 
 Simon Grant   eec 13 
 Paul Palcsek   h 12 

 Jenny McKnight    9 

 Martijn Van der Kamp    7 

 John Fullard    6 

 Claire Lubienski    5 
 Neil Cunningham   eec 5 

 Sheree Gordon    3 

 John Harrison    3 

 Albert Kaminsky    3 

 Geoff Roche    3 
 Grace Blake    2 

Novice Grade Open Prints 

 Name Jun Jul Total 

 Mark Smith  eeh eee 40 

 Gary Richardson  eee eeh 37 

 Marg Huxtable  eee eeh 36 

 Ray Huntley  eep eeh 33 

 Alan Donald  eee eec 31 

 Joshua Reuveni  eee eeh 30 

 John Spring  eec eec 30 

 Tuck Leong  eeh eec 29 

 Kelvin Rowley  eee eec 28 

 Martin Clancy  eec eec 25 

 Phil Marley  eee eee 24 

 Ian Bock  eee eee 22 

 Charles Kosina  eee eec 22 

 Jane Clancy  eee eee 21 

 David Purdue  ech  20 

 Sue Block   eec 16 

 Annette Donald  eee eee 14 

 Leif Andersen  ee  12 

 Annette James  eeh eec 12 

 Nicole Andrews   ech 9 

 George Chan   ech 9 

 Peter Walton   eeh 7 

 Barbara Butler   ec 5 

 John Parkinson    3 

 Robert Norman  ee  2 

A Grade Open EDI 
 Name June July Total 
 Ken Warburton  eeh eec 34 

 Chetan Kumar  ecp  33 

 Joanne Rinaldi  eee ecp 33 

 Guy Toner  eee ech 32 

 Sheryl Opie  eee ehp 31 

 Bharath Ramalingam  eeh  31 

 Barry Hogan  eee ech 26 

 Dmitri Illarionov  eec eee 25 

 John Morgan  eee ecc 24 

 George Chan  eeh  23 

 Sharon King  ech eee 23 

 Robert Fairweather   eee 22 

 Rob Gullan  eec eee 22 

 Karin Kowalski  ee eee 22 

 Robert Norman    17 

 Simon Beaven   eec 14 

 Neil Brink    11 

 Linda Herd  eec  11 

 Alan Harper  eee  10 

 John Godfrey    9 

 David Runci  eee eee 9 

 Jim O'Donnell    6 

 Andrew Ammendola    5 

 Bob Hayter    5 

 Kristina Arnott    3 

 Sidney Buchbinder    3 
 Nino Xerri  eee  3 

B Grade Open EDI 

 Name Jun Jul Total 
 David Ellis  h c 22 

 Ian Bock  e h 16 

 George Chan  c  16 

 Peter Tredrea  e c 14 

 Lesley Bretherton  c e 10 

 Ken Bretherton  e c 10 

 Marg Huxtable  c c 10 

 John Spring  e e 10 

 Guy Toner   e 10 

 Ken Warburton  e e 8 

 Judi Mowlem  e  7 

 Robert Fairweather  e  6 

 Rob Gullan  e  6 

 Jim O'Donnell  e e 6 

 John Parkinson  e e 6 

 Joanne Rinaldi  e e 6 

 Neil Brink  e  4 

 Mark Devaraj  e e 4 

 Julie Ughetti  e  4 

 John Harrison  e e 3 

 Kathryn Hocking    3 

 Annette James    3 

 Charles Kosina  e  3 

 Peter Walton    3 

 Karin Kowalski    2 

 Robert Norman  e e 2 

 Leif Anderson    1 

 Shelly Black  e  1 

 Colin Booth  e  1 

 Martin Clancy    1 

 Rueben Glass  e  1 

 Alan Harper    1 
 Gail Morgan    1 

Set Subject Prints 

 Name Jun Jul Total 
 Bharath Ramalingam  c  16 
 Tuck Leong  h c 14 
 Joshua Reuveni  e h 14 
 Ken Warburton  e e 14 
 Marg Huxtable  e c 12 
 Joanne Rinaldi  e h 12 
 Gary Richardson  e c 11 
 Alan Donald  e e 10 
 Rob Gullan  e e 10 
 John Spring  e e 10 
 Martin Clancy  h e 9 
 Robert Fairweather   h 9 
 Barry Hogan  e e 9 
 Ian Bock  e h 8 
 Kelvin Rowley  c e 8 
 Jane Clancy  e e 7 
 Dmitri Illarionov  e e 5 
 Charles Kosina  e e 5 
 Mark Smith  e  5 
 George Chan  e c 4 
 Sharon King  e e 4 

 Karin Kowalski    4 
 John Morgan  e e 4 
 Nicole Andrews   c 3 
 Simon Beaven   e 3 
 Jim O'Donnell    3 
 Peter Walton   c 3 
 Sue Block   e 2 
 Sheryl Opie   e 2 
 David Purdue  e  2 
 Guy Toner   e 2 
 Andrew Ammendola    1 
 Leif Anderson    1 
 Vanessa Bieri    1 
 Barbara Butler    1 
 John Godfrey    1 
 Jacqueline Goss  e  1 
 Tori Haeusler  e  1 
 Linda Herd  e  1 

 Annette James   e 1 

 Chetan Kumar    1 
 David Runci   e 1 

Set Subject EDI 

Points Scoring System 
 

Entry (no award)   e  1 point 
Commended   c  3 points 
Highly commended  h  5 points 
Print/EDI of the Month  p  6 points 
(5 for highly commended plus 1 extra) 

Exposure Editors 
 

Editor in Chief - Phil Marley 
Technical Editor - Charles Kosina 

 

 We welcome articles on travel, image 
processing tips, photos and anything else that may 
be of interest to photographers. Please send to: 

mcc-exposure@melbournephoto.org.au 
 

Deadline for September-October issue 
is 30 Sept 2014 
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June Mono Print of Month  David Ellis  Thelma Ellis 

July Colour Print of Month  Judi Mowlen  The Thinker 

June Mono Print of Month   Peter Tredrea   Degraves Mill 



July Mono Print of the Month  Charles Kosina  Southern Alps from top of Treble Cone, near Wanaka, New Zealand 

June Colour EDI of Month  Peter Walton  Out in the cold 


